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Overview

The Internet is growing at an exceptionally fast and exponential rate. With hundreds of millions of
web pages on the Internet today it is very easy for your site to get lost amongst the incredible
amounts of information available. To navigate through this mass of information, Search Engines
are used as an efficient tool to help users find what they are looking for. Most Search engines will
index your site for free, but firstly they must know about it's existence on the Internet. To achieve
this task, you will need to submit your site address •URL‚ to each and every Search Engine.
There are literally thousands of Search Engines and Link Directories available on the Internet
today, and this number is steadily on the increase. To manually submit your web site address
•URL‚ to all of the Search Engines will take months of your precious time. SubmitWolf can
accomplish the same time consuming task in a matter of minutes!
SubmitWolf is a truly sophisticated automated Submission Wizard for the promotion of Web Sites
on the Internet. It can list an URL with hundreds of Search Engines and Link Directories literally
within minutes.

 

Features  Overview

Automated submission to thousands of Search Engines and Directories.
Automatic submission to the most appropriate Category for each site. You need only select one
Category and SubmitWolf does the rest.
Improved Category selection with a wider variety and more specific Categories to choose from.
Integrates with PrioritySubmit.com premium listing services and pay for inclusion engines
including, Overture Site Match, Yahoo Directories, ScrubTheWeb, Slider, whatUseek and many
others. 
SPAM control. Filter out your Search Engine selections based on the number of emails sent out
by any particular site. Useful if you find you receive a lot of unsolicited SPAM from the many FFA
link sites on the Internet today.
MultiSubmit Sites. Send your submission to over 500,000 FFA Pages thus boosting the amount of
traffic reaching your site in a very short amount of time. This done by attracting Spiders that will
help improve your ranking.
Submit your site with up to 50 concurrent connections at the one time. This feature helps your
submission run faster and smoother and more 'trouble-free'.
Windows Explorer style Engine management screen.
Popup Help wizard.
Self-Repairing Engine Scripts.
Full browser emulation and cookie support.
Free script upgrades for 12 months. To keep your program up-to-date, an upgrade is released
daily. 
FREE e-mail support.
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Program  Versions

There are three basic versions of SubmitWolf, a Demo version, a standard version and an
Enterprise Edition.
SubmitWolf Demo
In the demo version, most Sites are disabled and URLs can be posted to 4 search engines. It is
designed to give you a feel for what the product can do.
SubmitWolf 
This version is designed for the average user. There are no restrictions as to the number sites
your URL will be submitted to. This version is intended for a single user to promote their own Web site.
SubmitWolf Enterprise
The Enterprise edition is designed for users who wish to submit their own URLs but also for third
parties. It can be used as the basis of a submission service. It contains additional import/export
features, advanced reporting and batch submit functionality.

 

Registering  Your Program

To register and upgrade your software, you will need to obtain registration details. To purchase a
registration key from the Trellian web site, Select Register from the Help menu of SubmitWolf, and
click on the "obtain registration key" link. Alternatively you may purchase the software from an
authorized Trellian software reseller. 
Once you have all of your details ready, follow these steps to register SubmitWolf. 
Step 1. - Select Register from the Help menu.

Step 2. - Enter your registration details. Registration details are case sensitive. Your username
will be the email address you registered with. If you have lost your registration details, click the
relevant link on the registration window, and follow the instructions. Click the Next  button to
continue. If your registration details are accepted, a thank you message is displayed 
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Step 3. - SubmitWolf will then begin searching for any missing components that you may be
entitled to download. It will then ask you whether you would like to download these components. Click 
Yes to upgrade now, or you can upgrade the components at a later date. The upgrade process
that follows will update SubmitWolf to the latest version and download the latest submission scripts. If
you do not upgrade, the full program features may not be available. 

 

System  Requirements

Operating Systems:
   Microsoft Windows 95/98/Me
   Microsoft Windows NT/2000/XP
Internet Browsers:
   Microsoft Internet Explorer 5.x/6.x
   Netscape Navigator 5.x/6.x
CPU/Processors:
   Intel Pentium I, II, III, IV, AMD or compatible
RAM/Memory:
   16Mb or greater •64Mb recommended‚
For further information, we suggest you take a look at http://www.trellian.com/swolf/index.html .

 

Upgrading

To keep SubmitWolf current, script upgrades should be installed. These upgrades are released at 
daily.
To download the latest upgrades, select the Upgrade option from the File menu. LiveUpgrade will
contact the upgrade server to check if there are any upgrades available. 
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All available components will be displayed in the selection list. All items that can be upgraded are
marked with a red clock icon. To upgrade these items, tick the checkbox next to the program and/or
component name and click the Upgrade  button. 
Items marked by a grey dot have not been installed. 
Items marked with a green tick are current and no update is required.

 

Support

FREE email support is offered to all registered users of SubmitWolf .
If you are experiencing problems, or are requiring answers to a technical question, please send us
an email detailing the issue, or issues that you are experiencing along with any other related
information to our Support Department.
You may contact this department by sending an email to support@trellian.com .
Support Hours:
Open Mon - Fri, 9:00am - 5:00pm •Melbourne, Australia - Eastern Standard Time‚
Please include your registration key, and some basic information about your computer and the
Operating System you are running. Also, before emailing support, please check the FAQ first, as
90% of all questions we receive are already answered on these pages. You can view the FAQ by
selecting FAQ from the Help menu. 
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Using  SubmitWolf

This chapter describes how to submit a URL.

 

Submission  Rules

The use of SubmitWolf is governed by an Acceptable use policy as outlined below. 

Please note that these policies are in place for a very good reason: the use of SubmitWolf
contrary to these policies will result in your IP address, URL or both being banned from many
search engines. 

1.  You may not use this program to SPAM search engines by submitting the same URL multiple 
times.

2.  You may not submit different URLs which are identical, or similar copies of the same page on
the same server. •Otherwise known as "mirror sites"‚

3.  You may resubmit a URL if there is a significant change both to the URL title and page
content. 

4.  You may not modify the submission rules to force the listing of inappropriate sites for a given 
engine.

5.  You may not force the submission to regionally specific engines if your site is not related
directly to the region. This includes submitting sites to domain specific engines if your site is
unrelated to and/or outside the domain.

6.  You may not submit more than one URL from the same site to search engines unless the
pages are unrelated or have significantly different content.
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7.  You must select the most appropriate category for your URL and you may NOT submit the
same URL to more than one category. 
For more information, please see the Frequently Asked Questions section.

 

Frequently  Asked Questions

Can I submit each page of my website?

No. Most engines specifically request that only the index pages is submitted. There are
two reasons for this: 

1.  To prevent multiple submissions creating a large backlog of sites for search engines
to index. Some search engines have people manually checking each website before
it is listed, so submitting each page is not necessary and will increase the size of the
submission queue. 

2.  Most search engines will spider each page of your website anyway. 
Many search engines will not index your website, or even ban your site if you submit it
too many times. 

How do I select an appropriate category for my website?

The category you select is important, as it dictates which search engines will be
submitted to. If you select an inappropriate category, your site will be submitted to
engines that are totally unrelated to your site. eg. submitting an Accountancy service
website to the Automotive / Cars category will most likely result in your website not being
listed, as its not about the automotive or car industry.
It is pointless submitting a website to an unrelated category. Not only will the engine not
list your website, but you will be targeting the wrong visitor base. If someone is looking
for a company to do Web design, they won't be looking in Automotive or Music search
engines, they will be looking on Computer and Internet related search engines.
The SubmitWolf categories are grouped logically. Please read the entire list before
selecting a category, as there may be a more suitable category further down the list. 
To select a category, you need to think what your website is mainly about. eg. A site
about cars would be in the Automotive category. A website selling shopping cart
software would be in the Internet / Software category. Even though the Automotive
industry may be able to use the shopping cart software, the shopping cart website is not
about cars. 
If you need help selecting a category, email support with your website URL and we will
advise you of the most suitable category for your site. 

What type of sites can be submitted to the Personal Home Pages category ?

The Personal Home Pages category is for personal sites, eg sites about John Smith,
John Smith's holiday photos, John Smith's family, John Smith's dog etc.. This category is
not for commercial / business websites. 

Can I submit my website to different categories?

No. Most engines specifically request that websites are submitted to ONE category only. 
Performing multiple submissions to different categories via SubmitWolf will be seen as a
multiple submission to a search engine, which is likely to result in a ban. 
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How often should I resubmit my website?

Many search engines request that you only submit your website once. These engines
are marked as "No resubmission" in SubmitWolf, and any attempts to resubmit to them,
will not be successful. This is to stop multiple submissions creating a large backlog of
sites for search engines to index. Many search engines will not index your website, or
even ban your site, if you submit it too many times. If you search for your website on a
search engine or directory and it is indexed, then it does not require a resubmission.

Link lists can be submitted to on a daily basis. The oldest links are replaced with the
newly submitted links, meaning that your link can be cycled off the list in a matter of
hours. SubmitWolf automatically allows multiple submissions to be made to the link lists.

Why are some engines manual?

Manual engines cannot be submitted to automatically for various reasons such as:
Some search engines and directories, such as Lycos and Yahoo, require the webmaster
to register and respond to a confirmation email, then log into the engine and finally
submit the website.
Most directories require the webmaster to browse through the directory's category
structure to find a suitable category, then submit the website.
Some engines require very specific information in order to submit the website. eg. Do
you accept Visa cards, which countries does your business ship to? etc.
Engines with very specific categories, e.g. Aromatic oils, French poetry, Small town
business directories, are also set to manual as they are too detailed to add as a
SubmitWolf category. 
The submission page requires a unique security code to be entered in order to validate
the submission. A different security code is generated for each page visit, and is
designed to prevent automated submissions. Engines that receive a large number of
spam or junk submissions will often implement security codes. 
In Submitwolf, Manual engines are marked with a grey gear image.

Why doesn't Submitwolf submit to Hotbot, MSN, Lycos, Yahoo etc.?

Many major engines only accept paid listings. e.g. MSN, Fast/Lycos, Overture,
Looksmart and Hotbot. For paid inclusion into these engines, visit 
http://www.prioritysubmit.com
Other engines, such as Yahoo, require manual submissions•see above FAQ item‚

Why does SubmitWolf skip engines?

All regionally specific engines are skipped if the URL being submitted does not
correspond to the region. For example if your website domain ends in au, the
website can only be submitted to Australian engines and standard english language 
engines.
Many engines have specific rules as to the type of sites they accept for listing. If the
data you have entered violates a rule for a given engine, it will be skipped. For
example, some engines do not accept adult sites or gambling sites. 
Some engines only accept websites about a specific category. For example, a
Travel search engine will only accept Travel related websites. If your website does
not fall into the Travel category, the engine will be skipped. 
Some engines only accept commercial websites, some only accept non commercial
websites. If your website is commercial, ensure your company/business name is
entered in the company/business name in the contacts screen. 
A number of engines are marked for manual submission for various reasons such
as: 
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The engine only accepts websites about a very specific category that
SubmitWolf does not list. eg. Aromatic oils, Dobermans, ASP code etc, 
The engine's submission process requires a constantly changing password or
code to be entered.
The engine only accepts websites from a specific region, state or province. 

My website isn't in French and/or doesn't have a French domain. Can I submit my
website to the French search engines?

Generally to be accepted in a foreign search engine, your site must contain information
about the country, provide a service to residents of the country or provide information
that is useful to people residing in that country.
Many search engines and directories will not list foreign sites in order to restrict their
search engine to businesses within their own country. 
For example, a website selling/advertising a house cleaning service in America, is not
relevant or useful to residents of France. 
In addition, many search engines will only list sites in particular languages. eg. German
search engines will only accept German language sites. SubmitWolf automatically
restricts submissions to search engines in countries that are not appropriate for your site. 
Websites that are not relevant are not accepted, and submitting non relevant sites is
considered as spamming the engine. Spamming search engines in this way leads to
engines restricting submissions by requiring a unqiue security code to be entered prior to
accepting the submission, or even implementing a pay per submission scheme. 

I have submitted my site, so why hasn't it been added to an engine?

The time taken for your site to appear varies greatly. It may be instant, or it may take several
months depending on the engine. The submit pages on most sites will give you an
approximation as to how long it will take for your site to appear. Submitting your site to an
engine does not guarantee that it will be listed, some engines may ban your website if they
receive multiple submissions. Some engines review all submissions manually and the
administrators can add or reject your submission at their discretion without notice. 

If you have any other questions, please contact the support team. 

 

Before  starting

If you are accessing the internet via a proxy server, first make sure that the proxy address and
port settings are entered correctly in Preferences. If you have a direct connection to the internet,
you can leave the proxy address blank, otherwise if the correct address is not specified,
SubmitWolf will not be able to connect to the Internet. Your ISP will inform you whether you need
to access the Internet via a proxy.
You may need to set the path to your web browser to view web pages and reports in SubmitWolf.
Web browser settings can be changed in Preferences 

 

Quick  start

This section provides brief instructions to get you started quickly
Step 1: Create a new project
Enter a project name in the project name window. 
Step 2: Enter URL details
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Select on the Project tab Fill in the URL detail fields.
Step 3: Select categories
Select the Category Tab and select categories to submit your web site to.
Step 4: Enter your contact details
Select the Contact Details tab and fill in the contact details. If your site is commerical •sells
something or is a business related site‚ ensure your Company name is entered. If your site is non
commercial •personal homepage or information website‚ leave the Company field blank. 
Step 5: Select the engines to submit to
Select the Engines tab and select the engines to submit to.
Step 6: Start the submission
Click the Submit  button.
Results:  You can view the submission reports by selecting the Reports tab.

 

Starting  A New Project

The first step is to create a new submission project file. Each URL to be submitted is treated as a
separate project, and you can only submit one URL at a time.
When SubmitWolf is started for the first time, you are prompted to enter a new project file name.
Enter a name for the project and click the OK button. 
You can create a new project at any time by selecting New Project from the File menu. 

If you are starting a new project, but have entered contact details in a previous project, you can
select the "Keep current contact details" checkbox. This checkbox is not displayed if there are no
existing contact details. 

 

Entering  URL Details

The next step is to enter as much information as possible about the URL •site location‚ of the web
site you are submitting.
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Enter the URL information in the Project tab. When you enter the URL, ensure that you include
the http:// prefix at the beginning. 
You can use Keyword Manager to easily fill in the URL Title, keywords and description fields. To
start Keyword Manager select Keywords from the View menu. Click the Import  button to import
the META tags from your web page. This will start Import wizard which will take you through the import
process. You can import META tags from a web page on your computer or directly from the Internet.
Ideally you should import the keywords from the page you are submitting.

The most important keywords should be entered in the fifteen boxes provided in order of
precedence. You may use single keywords or phrases, and try avoid using general keywords. 
Click the OK button to import URL Title, keywords and description fields into the Project tab. 
Most of the information on the project tab is required, and some search engines may not accept
your submission if these fields are not all filled in. For more information about the fields in the project
tab, see the Interface section of the manual.
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Category  Descriptions

The next step in the submission process is to select a category for your site. The tables below
provide a description of the categories available in SubmitWolf.

Personal  Home page

Category 
Name

Type of sites accepted

Personal
Home page

Personal sites only. eg. Sites about John Smith, John
Smith's dog/family/hobbies. Commercial sites not 
permitted.

Family Tree Family tree / Genealogy sites

Adult

Category Name Type of sites accepted

Adult BBS Adult BBS •Bulletin Board System‚ related sites

Film & Video Adult film and video related sites

CD Roms Adult CD Rom related sites

General
Adult sites that are not covered by any other 
categories

Literature Adult related literature eg. books and other media.

Live Sex Video 
Conferencing

Adult related Live video or webcams

Magazines Adult magazines

Merchandise and 
equipment

Sex shops and other adult related merchandise not
covered by other categories

Phone Sex Phone sex services

Services
Other adult related services not covered by other
categories eg. Escorts

Automotive
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Category 
Name

Type of sites accepted

Accessories / 
Spares

Automotive accessories and spare parts sales

Aviation
Aviation related sites. Aviation sites specific to the
tourism industry should be submitted to the Travel -
Airlines category.

Bikes/Vans/Trucks Motorbike/scooter/van/truck related sites

Boats Boat related sites

Cars
Car related sites. Car dealers should submit to the
Automotive - Dealers category.

Auto Clubs Auto / car club sites

Dealers Car dealer/sales sites

General
Automotive related sites not covered by any other 
categories

History Automotive history sites

Insurance Automotive insurance products and services

Manufacturers Automotive manufacturer sites

Rental Cars Rental car services

Services
Other automotive services not covered by any other 
categories

Business

Category Name Type of sites accepted

Accounting Sites promoting accounting services

Advertising/Marketing Sites promoting advertising and marketing services

Agriculture Agriculture related services

Banking

Banking related services. Mortgage related sites
should be submitted to the Real Estate - Mortgage
category. Sites promoting mortgage services should
be submitted to the Real Estate - Mortgages category

Business to 
Business

Business services for other businesses •B2B‚

Classifieds Sites offering classified ad services

Communications
Communications services. Mobile phone related sites
should be submitted to the Electronics - Mobile
phones category.
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Conferences
and Meetings

Sites offering conference and/or meeting 
facilities/services

Consultants Business consultant services

General
General business information not covered by any
other categories. Other business services should be
submitted to the Business - services category.

Import Export Import / Export services

Industrial Goods Industrial goods related sites

Legal
Sites offering legal information. Legal services/law
firm sites should be submitted to the Services - legal 
category.

Mail Order Mail order sales

MLM
MLM •Multi Level Marketing‚ sites. Also known as
Network Marketing.

Office 
Equipment

Office Equipment related services

Office Supplies Office supplies

Office furniture Office furniture

Opportunities
Work from home / business for sale / franchise 
opportunities

Printing Printing services

Resources Business resource information

Services
Other business related services not covered by any
other categories. Also check the Services category
before selecting the Business/services category

Stock Market Stock Market related services

Wholesale Wholesale services

Computing
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Category 
Name

Type of sites accepted

Books Computer related books

Consultant Computer consulting services

Dealers Computer dealers / shops

Games
Computer game related. Gambling games should be
submitted to the Entertainment - gambling category.

General
Other computer related sites not covered by any other 
categories

Hacking 
Phreaking

Hacking / phreaking related sites

Hardware Computer hardware 

Multimedia Computer multimedia 

Networking Computer networking related sites

Security Computer security related sites

Services
Other computer services not covered by any other 
categories

Software
Computer software. Sites promoting Internet related
software should be submitted to the Internet - software 
category.

Training
Computer training services. Sites promoting Internet related
training should be submitted to the Internet - Training 
category.

Consumer  Products / shopping

14



Category 
Name

Type of sites accepted

Antiques Antique products

Arts/Craft Arts/craft products

Beauty Beauty related products

Clothing Clothing related products

Electrical / 
appliances

Electrical products. Computer related products should be
submitted to the Computer categories.

Fashion Fashion products

Food Food and drink products

Furnishings Furnishing related products eg. furniture,curtains,carpets.

Gardening Garden products eg. plants, shovels, gloves.

General Other products not covered by any other categories

Gifts/flowers Gifts / flowers

Health
Health related products. Sites promoting Drugs/medicines
should be submitted to the Health - medicine category

Jewelry Jewelry

Toys/Novelties
Toys and other novelty/entertainment products. Adult
related products must be submitted to the Adult -
Merchandise & Equipment category

Education

Category Name Type of sites accepted

Adult Education Adult education services

Distance Distance education services

High School High schools

PreSchool Preschool services

Schools School sites

Services
Other education services not covered by any other 
categories

Supplies Educational supplies

Universities/Colleges University and College sites

Other
Other education related sites not covered by any
other categories
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Electronics

Category 
Name

Type of sites accepted

CD CD sales/services

DVD DVD sales/services

Mobile 
Phone

Mobile Phone sales and services •including ringtones‚

Television
Television sales/services/information. Sites related to
television programs should be submitted to the Entertainment
- Television category.

Radio
Radio sales/services/information. Sites related to radio
programs should be submitted to the Media - radio category

PDA
PDA •Personal Digital Assistant‚ sales/service/information.
eg. Pocket PC, Palm devices.

WAP WAP •Wireless Application Protocol‚ services/information

Other
Other electronics related sites not covered by any other 
categories

Employment

Category 
Name Type of sites accepted

Agencies Employment agencies/recruitment services

General
Other employment related sites not covered by any other
categories. Work at home and other "opportunity" related sites
should be submitted to the Business - Opportunities category.

Vacancies
Employment vacancies / job offers. Work at home and other
"opportunity" related sites should be submitted to the
Business - Opportunities category.

Job site
Job sites listing multiple vacancies eg.
http://www.seek.com.au 

Entertainment

Category 
Name

Type of sites accepted

Amusement 
Parks

Amusement Parks

Art
Art related sites. Sites selling Art should be submitted to
the Consumer Products - Arts/crafts category.

Celebrities Celebrity related sites
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Cinema Cinema related sites 

Cultural 
Events

Cultural events

Gambling - 
offline

Gambling/betting/lottery sites that do not offer an online
gambling service. This includes sites containing gambling
tips/rules/information/bots etc. 

Gambling - 
online

Gambling/betting/lottery sites that offer an online
gambling service

Games

Games related sites. Computer game related sites
should be submitted to the Computer - Games category.
Gambling related sites should be submitted to the
Entertainment - Gambling category 

General
Other entertainment related sites not covered by any
other categories 

Exhibitions Exhibitions and shows 

Humor Humor/comedy related sites 

Literature

Literature related sites. Adult/sex related literature should
be submitted to the Adult - Literature category.
Magazines and Newspapers should be submitted to the
Media - Magazines and Media - Newspapers categories. 

Magic
Magic shows/services. Sites discussing magic should be
submitted to the Paranormal - Magic category 

Museums/Galleries
Museum and Gallery sites. Sites selling art/crafts should
be submitted to the Consumer Products -Art/Crafts
category 

Music
Music entertainment services/ sites. Sites promoting
music products should be submitted to the Music/CD's or
Music DVD's category.

Restaurants/food
Restaurants, cafes and food services. Recipe and
cooking related sites should be submitted to the
Recreation - Eating/drinking category

Television/Radio
Television/radio related sites. Sites selling or servicing
televisions/radios should be submitted to the Electronics
- Television or Electronics - Radio categories. 

Theatre Theatre related sites 

Visual Arts
Visual Arts related sites. Sites selling Art should be
submitted to the Consumer Products - Arts/crafts
category. 
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Finance

Category 
Name

Type of sites accepted

Accounting
Accounting related sites. Sites promoting accounting
services should be submitted to the Business - Accounting 
category.

Banking
Banking related sites. Sites promoting banking services
should be submitted to the Business - Banking category.

General
Other finance related sites not covered by any other
categories .

Insurance
Insurance related sites. Sites promoting vehicle insurance
services should be submitted to the Automotive - Insurance 
category.

Investments Investment related sites.

Loans/Credit
Loans/Credit related sites. Sites promoting mortgage
services should be submitted to the Real Estate - Mortgages 
category.

Mortgages
Mortgage related sites. Sites promoting mortgage services
should be submitted to the Real Estate - Mortgages 
category

Health  / Medical
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Category 
Name

Type of sites accepted

Alternative 
Medicine Alternative Medicine related sites

Disabilities Disability related sites

Diseases

Disease related sites. Sites promoting medicine/drugs should
be submitted to the Health - Medicine category. Sites
promoting health products should be submitted to the
Consumer products - Health category.

Hospitals Hospital sites

Fitness

Fitness related sites. Sites promoting health products should
be submitted to the Consumer products - Health category.
Sites promoting medicine/drugs should be submitted to the
Health - Medicine category.

Supplies

Other health/medical supply related sites. Sites promoting
health products should be submitted to the Consumer
products - Health category. Sites promoting medicine/drugs
should be submitted to the Health - Medicine category. 

Medical 
Centers

Medical Centers

Medicine
Medicine/drug related sites. Sites promoting health products
should be submitted to the Consumer products - Health 
category.

Mental 
Health

Mental Health related sites. Sites promoting mental health
services should be submitted to the Services -
Health/Medical category.

Nursing 
Homes

Nursing Homes

Nursing 
Agencies

Nursing Agencies

Industry
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Category 
Name

Type of sites accepted

Agriculture
Agriculture industry related sites. Sites promoting
agricultural services should be submitted to the Business -
Agriculture category.

Chemicals Chemical industry related sites.

Construction
Construction industry related sites. Sites promoting building
services should be submitted to the Services - Building 
category.

Electronics

Electronics industry related sites. Sites promoting electrical
products/services should be submitted to the Electronics
category or the Consumer Goods - Electrical / appliances 
category.

Food

Food industry related sites. Sites promoting food/drink
products should be submitted to the Consumer Products -
Food category. Sites promoting Restaurants, cafes and
food services should be submitted to the Business -
Restaurants category. Recipe and cooking related sites
should be submitted to the Recreation - Eating/drinking
category 

Gas Gas industry related sites

Machinery Machinery industry related sites

Manufacturing Manufacturing industry related sites

Metals Metal industry related sites

Mining Mining industry related sites

Oil Oil industry related sites

Pharmaceuticals

Pharmaceuticals manufacturing industry related sites. Sites
promoting health products should be submitted to the
Consumer products - Health category. Sites promoting
medicine/drugs should be submitted to the Health -
Medicine category. 

Plastics Plastic industry related sites

Petrochemicals Petrochemical industry related sites

Rubber Rubber industry related sites

Textiles
Textile industry related sites. Sites promoting
clothing/textile products should be submitted to the
Consumer Products - Clothing category.
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Internet

Category 
Name

Type of sites accepted

Access 
Providers

Internet Access providers. This is for sites that offer Internet
access only •eg. an IP address only‚, not other services such
as email, support, newsgroups etc. Sites promoting ISP
services should be submitted to the Internet - ISP's category. 

Consultants Internet consultant services.

General

Other Internet related sites not covered by any other
categories. Personal home pages should be submitted to the
Personal Home Pages category. Online stores should be
submitted to the Internet - Online Store category.

ISPs ISP •Internet Service Provider‚ sites

Online 
Store

Online stores

Resources Internet resources. eg. Script archives, image archives,
information about the Internet, tutorials etc.

Software
Internet software related sites. Sites promoting software not
related to the Internet should be submitted to the Computer -
Software category.

Training
Internet training services. Sites promoting non-Internet
related computer training should be submitted to the
Computer - Training category. 

Web site 
providers

Web site/hosting/domain services. Sites promoting Web site
design services should be submitted to the Internet - Web
site design category.

Web site 
design

Web site design services/information

Media
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Category 
Name

Type of sites accepted

Advertising/Agencies Media agencies

Consultants Media consulting services.

Film
Film industry related sites. Sites discussing films,
reviews etc. should be submitted to the Entertainment -
cinema category.

Newspapers Newspaper sites

Magazines
Magazine sites. Sites discussing magazines, reviews
etc. should be submitted to the Recreation - Magazines 
category.

Productions
Media production sites. eg. Music/video/tv/radio
production services.

Public 
Relations

Public Relations sites

Publishing Publishing related sites

Radio

Radio industry. Sites selling or servicing radios should
be submitted to the Electronics - Radio category. Sites
discussing radio programs for entertainment purposes
should be submitted to the Entertainment -
Television/Radio category.

Services
Other media related sites not covered by any other
categories. 

Telecommunications

Telecommunications related sites. Sites selling or
servicing radios or Mobile phones should be submitted
to Electronics/Mobile Phones and Electronics/radio
categories respectively.

Television

Television industry. Sites selling or servicing
Televisions should be submitted to
Electronics/Televisions category. Sites discussing
Television programs for entertainment purposes should
be submitted to the Entertainment - Television/Radio 
category

Video Video industry. 

Music
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Category Name Type of sites accepted

Asian Asian music sites

CDs CDs sales

Classical Classical music sites

Country Country music sites

DVDs Music DVD sales

Fan sites Band/artist fan and information sites

General Other music sites not covered by any other categories

Gospel Gospel music sites

Heavy Metal Heavy Metal music sites

Hip hop Hip hop music sites

Instruments Musical Instruments

Jazz Jazz music sites

Pop Pop music sites

Latin Latin music sites

MP3 MP3 related sites

New Age New age music sites

Opera Opera related sites

Rock Rock music sites

Soul Soul music sites

Techno Techno music sites

World Music World music sites

Paranormal
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Category 
Name

Type of sites accepted

ESP ESP •Extra Sensory Perception‚ 

Ghosts Ghost related sites

Kryptozoology Kryptozoology sites

UFOs UFO •Unidentified Flying Object‚ sites

Magic
Magic sites. Sites promoting a magic service/show should
be submitted to the Entertainment/Magic category.

Parapsychology Parapsychology sites

Spectrology Spectrology sites

Telekinesis Telekinesis sites

Fairy 
Appreciation

Fairy related sites

Politics/Government

Category 
Name

Type of sites accepted

City City level of politics/government

Embassies Embassies

Federal Federal level of politics/government

General
General political/government related sites not covered by
any other categories 

Regulatory Governmental Regulatory sites

Consultants Political/government consultants

Legislative Legislative related sites

Military Military sites

Services Political/government services

Tax
Tax information. Sites promoting accounting/tax services
should be submitted to the Business - Accounting category

County County level of politics/government

Provincial Provincial level of politics/government

State State level of politics/government

Other
Other political/government related sites not covered by any
other categories
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Real Estate

Category 
Name

Type of sites accepted

Agents Real estate agents

Architecture Architects/architecture

Brokers Real estate brokers

Builders
Building/construction information. Sites promoting building
services should be submitted to the Services - building
category 

General
Other real estate related sites not covered by any other 
categories

Mortgages Mortgage/home loan products and services

Properties Properties for sale

Rentals Rental properties

Repair Repair services

Surveying Surveying services

Services
Other Real estate related services not covered by any other 
categories

Recreation
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Category 
Name

Type of sites accepted

Books/Videos Books and videos reviews/discussion. Sites selling books
should be submitted to the Reference/books category

Clubs/Hobbies Clubs/Hobbies

Dating Dating services

Eating/Drinking

Recipe and cooking related sites. Sites promoting food and
drink products should be submitted to the Consumer
products - Food category. Restaurant/cafe/food service
sites should be submitted to the Entertainment -
Restaurants/food category 

Garden
Gardening related sites. Sites promoting gardening
products should be submitted to the Consumer Goods -
Gardening category

General
Other recreation sites that are not covered by any other 
categories

Home
House and home related sites. Sites promoting products
should be submitted to the Consumer Goods category

Magazines
Magazine discussion. Sites promoting magazines should be
submitted to the Media - Magazines category

Music

Hobby related music sites. Sites promoting music products
should be submitted to the Music/CD's or Music DVD's
category. Sites providing a music service shold be
submitted to the Entertainment - music category.

Outdoors Outdoor activity sites

Pets/Animals Pets/Animal sites

Photography

Photography sites. Sites promoting photography services
should be submitted to the Services - photography
category. Sites selling photography should be submitted to
the Consumer goods - Arts/Crafts category

Reference
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Category 
Name

Type of sites accepted

Books Books

Directory
Directories eg. http://dmoz.org NOTE: This category is for
sites that ARE directories.

Encyclopedia Encyclopedias

History History

Libraries Libraries

Search 
Engine

Search Engines eg. http://www.google.com. NOTE: This
category is for sites that ARE search engines.

Other
Other reference related sites not covered by other 
categories

Publishers Publishers

Religion

Category 
Name

Type of sites accepted

Experiences Religious experiences

Services Religious services

News Religious news

Churches Churches

Philosophy Philosophy

Supplies Religion related products

Other
Other religion related sites not covered by other 
categories

Services
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Category 
Name

Type of sites accepted

Announcements Announcement services

Building Building services

Charities Charities

Cleaning Cleaning services

Courier Courier services

Electrical Electrical services / electricians

General Other services not covered by other categories

Health/Medical
Health and medical services. Massage and optical
relates sites should be submitted to the relevant
category in services.

Investigation Investigative services

Legal Legal services

Logistics Logistics services

Massage Massage services

Optical Optical services

Organizations Organizations ?

Photography Photography services

Printing/Graphic 
Design Printing/Graphic Design services

Plumbing Plumbing services / plumbers

Quality Control Quality Control services

Security Security services

Spiritual Spiritual services

Veterinary Veterinary services / vets

Weather Weather services

Science  & Technology
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Category 
Name

Type of sites accepted

Agriculture

Agricultural science related sites. Sites promoting
agricultural services should be submitted to the Business -
agriculture category. Sites related to the agricultural
industry should be submitted to the Industry - agriculture 
category.

Biotechnology Biotechnology sites

Chemistry
Chemistry sites. Sites related to the chemical industry
should be submitted to the Industry - chemicals category.

Consultants
Science/technology consultants. Internet/computer
consultant sites should be submitted to the Internet -
consultants or Computer - consultants categories.

Engineering Engineering sites

General General science sites not covered by other categories

Geography Geography sites

Mathematics
Mathematics sites. Sites promoting Mathematics software
should be submitted to the Computer - software category.

Medicine
Medical science related sites. Sites promoting
medicine/drugs should be submitted to the Health -
medicine category.

Other Other science sites not covered by other categories

Paleontology Paleontology sites

Physics Physics sites

Psychology
Psychological science sites. Sites promoting psychology
services should be submitted to the Services -
Health/medical category

Research Scientific Research sites

Science Science sites

Services Science and technology services

Space/Astronomy Space/Astronomy sites

Sports

Category 
Name

Type of sites accepted

Athletics
Athletics sites. Sites promoting health products for athletes
should be submitted to the Health - medicine category.

Billiards Billiards sites
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Badminton Badminton sites

Basketball Basketball sites

Baseball Baseball sites

Bowling Bowling

Chess Chess sites

Cycling Cycling sites

Equestrian Equestrian sites

Extreme 
Sports

Extreme Sports sites

Fishing Fishing sites

Flying Flying/recreational aviation sites

Football Football sites

Formula 1 Formula 1 sites

Gymnastics Gymnastics sites

Golf Golf sites

Handball Handball sites

Hockey Hockey sites

Ice Skating Ice Skating sites

Martial 
Arts

Martial Arts sites

Motor 
Sport

Motor Sport sites. Sites promoting automotive products
and/or services should be submitted to the Automotive 
categories.

Olympics Olympics sites

Other Other sports sites not covered by other categories

Para 
Gliding

Para Gliding and other aerial flight related sites

Rugby Rugby sites

Skateboarding Skateboarding sites

Skating Skating sites

Skiing Skiing sites

Snowboarding Snowboarding sites

Softball Softball sites

Soccer Soccer sites
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Surfing Surfing sites

Table 
Tennis

Table Tennis sites

Tennis Tennis sites

Shooting Shooting sites

Squash Squash sites

Swimming Swimming sites

US 
Football

US Football sites

Volleyball Volleyball sites

Wrestling Wrestling sites

Water 
Sports

Water Sports sites

Travel

Category Name Type of sites accepted

Activities Travel related activities sites

Airlines Airline sites

Car Rentals Car Rentals specifically for tourists/tourism

Cruises Cruises

General
General travel related sites not covered by other
categories 

Holidays Holidays

Hotels/Accommodation Hotels/Accommodation sites

Hot Springs Hot Springs

Tourist Info Tourist Information

Tours Tours

Transport
Transport sites related to the Travel/tourism 
industry

Travel Agencies Travel agents
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Selecting  a category

The next step is to select the categories that describe the purpose of your web site. 
Directories will only list your site under ONE category, so it's very important to select the most
suitable category for your website.
Generally search engines are not based on categories unless they are category specific search
engines. eg. Travel search engines, or Animal search engines. 
Click on the Category  Tab to select categories.

Adding a category
Identify which category your web site fits into from the list. Select the most Expand the category
listing by clicking the plus symbol next to the category name. 
The available sub categories are marked with a green diamond. Select the sub category that best
describes your web site and either drag it into the "Submit to" part of the window, or click the -->
button. 
Repeat these steps to add more categories. 

Removing a category
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To remove a category, select the category from the "Submit to" part of the window, and either
drag it back to the category lists, or click the <-- button. 
Note: Submitting URLs to inappropriate categories is contrary to the acceptable use policy.
Directories request that only one submission per site is made, using one category only. Any further
submissions made to the directories using different categories may result in your site being totally
banned from the directory. 

 

Entering  contact details

The next step is to enter your contact details.
Select the Contact Details  tab. 

Most of the information on the Contact Details tab is required, and some search engines may not
accept your submission if these fields are not all filled in. The email address entered must be valid
as some engines will send a confirmation email that must be replied to. 
If your website is commerical •sells something or is a business site‚ ensure your Company name
is entered. If your site is non commercial •personal homepage or information website‚ leave the
Company field blank. Some search engines only accept business websites, and SubmitWolf
determines which engines to submit to based on the Company field. 
Warning:  The email address entered may be used to send you unwanted email •spam‚. The
email column in the Engine tab shows the average number of emails received after a submission
to the engine. Using a free email address •hotmail, yahoo etc‚ or a non important email address is
recommended. 
For more information about the fields in the Contact Details tab, see the Interface section of the 
manual.
Note: Most engines do not publish your contact details, however they may appear as part of your
listing on some online directories. 
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Selecting  Engines

Once you have entered all the details and selected your category, click on the Engines  tab to
bring up the engine selector screen.

You will be presented with a list of engines that will accept your URL based on the details you
have entered.
Select the engines you wish to have your URL submitted to, by ticking the checkbox next to each
engine name. You can select/deselect all sites at once by selecting the All  folder on the left hand
side and clicking the Select All  button on the right hand side. 
The engines are divided into a number of categories. These are accessed via the folders on the
left hand side. Engines in each category can be selected separately.

Image: Category: Description:

Engines All the engines are found in the Engines  folder

Link 
Lists

These sites are link directories. Link directories usually
list URLs by category. Most Link lists are not searchable
are found in the Link Lists  folder

Multi 
Submit

These sites list your URL with more than one page or
site at once. Most are not searchable. Multi Submit
engines are found in the Multi Submit  folder

Manual
Sites 

These are sites for which SubmitWolf does not have an
automated submission script. This is either because it is
too difficult to create such a script, the site is too
specialized, or a script has not yet been written and may
be available in the next upgrade. For manual submission
details see the Manual submission section of the
manual. Manual Submission engines are found in the 
Manual  folder

Trash
The trash folder contains sites that have been deleted
from the other sections. To restore an engine, drag it
from the trash into the desired folder.
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Note: The FFAnet Link Lists requires a one time validation of your email address BEFORE any
submissions are accepted. Enter the email address you will use for submissions at 
http://www.ffanet.com/auth/, wait for the reply message, then confirm your email address. You can
then submit to any FFAnet Link List. 
For more information about the fields in the Engines tab, see the Engine Selector section of the 
manual.

 

Submitting  Your URL

You should now be ready to submit your URL. 
Make sure that you are connected to the internet, and click the Submit  button. SubmitWolf will
display a confirmation screen with a summary of the information to be submitted. All fields with
headings that are highlighted in grey are mandatory. SubmitWolf will display an error message if
one or more of these fields have not been filled in. You will have to fill in these fields before being
able to submit. 

This is your last chance to modify any details before submission.Click the Submit  button to 
proceed.
Depending on the speed of your connection, and the number of sites selected, the submission
process should take between 2 to 10 minutes.
The Skip  button is used only in the Enterprise version, and can be used to ignore certain projects
in batch submissions.

 

Connection  status window

The Connection status window of SubmitWolf is designed to provide a visual feedback of all the
web sites that are being contacted and submitted to. It provides an indication as to which sites are
being contacted, which sites are responding to the contact, and the sites that have failed or are
still yet to respond. To cancel the submission, click the Cancel  button. 
SubmitWolf can submit up to 50 web sites concurrently during submission. In the Enterprise
version, 1024 web sites can be submitted to concurrently.
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Connection status values  
Pending:  
Sites that have either not received a submission or are yet to respond.
Submitted:  
Sites that have successfully received your submission.
MultiSubmit:
Sites that have received your submission and re-submitted it many thousands of times to other
sites. These numbers represent how many sites have been successfully submitted to.
Failed:
Sites that have experienced errors with their servers, may have moved or removed their
submission page without warning, or that they are simply experiencing temporary network
problems. The sites that are experiencing problems or are not responding will usually cause a
timeout error and be regarded as a 'Failed' submission. You may view the response the
submission received from most sites by pressing the Response button from within the Report Tab. 
Skipped:
Sites that have not yet been selected for submission will be skipped, as will sites that are not
appropriate for the category or domain that you selected.
Note: If you wish to stop a submission without completing the process, select OK from the status
screen and then cancel from the main screen.
Idle: 
This means that SubmitWolf has either queued the web page and is simply 'waiting' for a
connection to become available, or there is no response from the web site as of yet. 
Connecting: 
This indicates that the web site in question has been contacted and SubmitWolf is attempting to
make a connection. 
Connected: 
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This indicates that the web site in question has been contacted and has made a successful
connection. 
Resolved: 
This indicates that the web site's domain name has been resolved to an IP address. 
Timed Out:
This indicates that the web page has not responded, or has taken too long to respond. If this is
occurring frequently, try increasing the Time out setting in Preferences. 

 

Manual  Submissions

SubmitWolf has several hundred Search Engines in its database which are not automated at
this time. These Engines, which need to be submitted to manually, are listed inside the
Manual Folder under the Engines Tab.
If you wish to submit your site to these engines, this has to be done by visiting the submit
page of each engine individually. The following steps show how simple it is to perform this
type of submission: 
Step 1.
From the Engines Tab view, right click on an Engine entry and select Open from the popup 
menu.
This will take you to the Submit Page of the Engine.

Step 2.
To submit your site, cut and paste the relevant information from SubmitWolf into the online
Submission Form.
You can keep track of your manual submissions by marking a manual site as Submitted.
Right click on a Manual Engine entry and select Mark as Submitted from the popup menu. 
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Submission  Report

To view the submission report, click on the Report Tab. The Report Tab contains detailed
information about your submission. For information on report generation for the Enterprise version,
see the Enterprise section of the manual. 

A small icon next to each Engine name indicates the submission status of that site. This key
is also used on the Engine tab. The following key explains the meaning of each icon:

Icon: Meaning: Description: 

Submitted The URL has been successfully submitted to the site

Pending A submission has not been made to this site.

Failed 
A submission to the site failed or returned an error. The exact cause
for the failure is given in the report

Moved 
The response page of this site has moved and SubmitWolf has not
been able to determine whether the submission has failed or 
succeeded

Timeout 
An attempt has been made to submit to the site, but the connection
timed out before the submission was complete. 

To view the individual engine response, select the engine from the list and click the 
Response  button. 
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For more information about the Reports tab, see the Interface  section of the manual. 
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Submission  Projects

This chapter describes working with Submission Projects.

 

Saving  A Project

You can force SubmitWolf to save any changes to your Submission Projects by
selecting the Save option from the File  menu. Projects can also be saved under a
different name by using the Save As option instead.

Note: SubmitWolf also saves changes to your Submission Projects automatically. This
activity is mainly performed before and during a submission. Also, SubmitWolf will
automatically save your project when you load a New Project into the Project List, or
when you exit the program.
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Deleting  Projects

To delete a Submission Project, click on the Project tab. Select the project to delete
and select Delete from the file  menu. SubmitWolf will then confirm that you want to
delete the project, or to remove the icon from the project list without deleting the
project. Select the option you desire and click the OK button. 

Projects can also be deleted using the Project Manager or by right clicking the project
to be deleted, and selecting Delete from the popup menu. 

Warning : Deleting a Submission Project is PERMANENT, and once deleted, a project
can not be restored.

 

Resetting  A Project

The Reset Project  command in the Options  menu can be used to reset the status of the
project. This will restore the Project to a default state clearing all previous Submission
Status flags and settings.
This option should be used ONLY if you wish to re-submit your page to all the Search 
Engines. •eg: If the page content has changed since the last time you submitted the
same page‚.

Note: There are strict policy guidelines for re-submissions, so please read the
Acceptable Use Policy first before re-submitting a site. Frequent re-submissions are
considered as SPAM and this may result in the removal or downgrading of your listing
from some engines. What this means is that if Search Engines receive the same
submission often in a short period of time, they might reject your submission, give
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you a lower ranking, or even ban you from re-submission all together.
We suggest that you do not resubmit the same web page to the same Search Engines
more than once a month.  

 

Project  History

Each project has its own submission history which you may use to keep a record of
your submissions with. This is a most useful feature and allows you to keep track of
the progress of your submission success. Each submission project records the
time/date and the number of successful submissions made. To display the Submission
History window right click the project icon in the Project Tab and select View then 
History  from the popup menu
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The Engine Tab

This chapter covers the Engine Tab.

 

Site  Status

A small icon next to each Engine name indicates the submission status of that site.
The following key explains the meaning of each icon:

Icon: Meaning: Description: 

Submitted The URL has been successfully submitted to the site

Pending A submission has not been made to this site.

Failed 
A submission to the site failed or returned an error. The exact cause
for the failure is given in the report

Moved 
The response page of this site has moved and SubmitWolf has not
been able to determine whether the submission has failed or 
succeeded

Timeout 
An attempt has been made to submit to the site, but the connection
timed out before the submission was complete. 

* Note: if you get too many timeout errors, you should either check your proxy settings
in preferences , and/or increase the timeout  delay value.
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Program  Buttons

Button Description

Submit Starts the submission process to the currently selected engines.

Help Launches the pop-up help dialog to provide help on any selected item.

New Creates a new engine in the list.

Edit Allows you to edit the currently selected engine.

Delete Places the currently selected engine•s‚ into the trash bin.

Select All Selects All items in the current folder.

Pending Selects the sites that have not been submitted in the current folder.

Submitted Select all sites that have been successfully submitted to in the past.

Clear Deselect all sites in the current list.

 

Selecting  All Engines

To select all engines, go to the Engines tab, then press the Select All  button on the
right hand side of the interface. You can also select all of the engines in a
particular category using the same method. On the Engines tab click on the
appropriate category, then press the Select All  button on the right hand side of the 
interface.
You cannot Select All engines in the manual tab. You can only right-click and open
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to visit the site.
The Pending  button should be used if you are re-submitting a project so that you
do not get duplicate submissions to the same site.

 

Grouping  Engines

Select the engines tab, in the left hand side of the tab, with in the folder tree right
click and select New Folder  within the folder tree, from the pop-up menu to create
your own folder to store engines in. You can then drag and drop engines into your
folder or create new ones in the folder using the engine wizard. This is particularly
useful for submitting to select groups of engines.
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Deleting  Engines

To delete an engine, right click on the engine name and select Delete from the
popup menu.
Deletion of Custom engines is permanent. Default engines can be undeleted by
simply dragging them from the trash back into the engine list.

 

Displaying  Engine Properties

The submission status of each engine can be modified. In the engine list, Right
Click on an engine entry you wish to view, and select Properties  from the popup 
menu:
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Editing  Submission Status

Engine Submission status can be modified from the Properties  dialog. Right-click
on an Engine entry, then select Properties  from the popup menu that appears.

Status The current status of a submission as it appears on the reports.

Time/Date The time and date of the last submission.

Times How many times the current URL has been submitted to the engine.

Mark Sets the status of the engine to Submitted. This option is typically used
to keep track of submissions done outside SubmitWolf.

Reset Resets the Submit Status back to zero.

Report Displays the response returned by the engine to the last submission.

To make your changes permanent, click the OK button.

 

Clearing  Submission Status

Right Click on an Engine Entry and Select Properties  from the popup menu. Click 
Reset  to clear the submit status of the selected engine. To make the changes
permanent, click the OK button.
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The Reset  button, in the Engine Properties Dialog, will also erase all submission
statistics for the current engine. This can be used to force a second submission to engines
which have the NOSPAM rule, which would otherwise prevent multiple submissions of the
same URL, by deleting the submission history. 

 

Engine  Expansion Pack

You can now update your SubmitWolf subscription to include regional Search
Engines. The cost ranges from only US$14.95 to US$49.95 per domain and
includes 12 months of free updates. 
To activate these, simply run SubmitWolf click on the Engines  tab and select the
region •FLAG‚ you would like activated. 
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Enterprise  Edition

The Enterprise  Version of SubmitWolf has many additional features which are not
available in the standard version. Most of these are designed to make the task of
submitting multiple projects even easier, with an emphasis on providing all of the
features necessary to start a full-scale submission service of your very own.
The Enterprise Version and all of it's features are covered in the following chapter.

 

Batch  Submissions

Multiple projects can be submitted simultaneously as a single batch job. This is
useful if you have a very large collection of client submissions or own multiple
URLs that you wish to submit in a single, continuous process but simply do not
have the time to submit each individually. You can select a group of projects and
then submit these automatically in a batch, even allowing them to run overnight.
To submit a batch of submission projects, you will first need to create a separate
project for each URL that is to be submitted, and then enter the project details as
described in Chapter 2 of this manual. 
Once you have created all of the projects you wish to submit, select Project 
Manager  from the View menu. To add a project to the batch submission list, right
click the project and select Add to Batch  from the popup menu. 

To remove a project from the batch submission list, select the project then right
click and select Delete from the popup menu.To remove all projects from the
submission queue, click the Clear  button. 
To start the batch submission click the Start  button. 
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Submission  Report

A Submission Report is created for each project in the project directory. This
report is called report.htm. This report is retained permanently. The Submission
report contains the name of the site submitted to, submission status, last
submitted date and times, link to the submission web page and the category the
site was submitted into.

To view the Submission report, select Project Manager  from the View menu
option. Select the project you want a submission report for, and select 
Submission  from the Reports  menu option. 
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Detail  Report

A Detail Report is created for each project in the project directory. This report is
called details.htm. This report is retained permanently. The detail report contains
the URL details and the contact details but have no submission information in 
them.

Unlike the submission report, the detail report can be customized to include a
company name, logo etc. The look and feel of the detail report can be changed and
fully customized by modifying the files found in the Template directory inside the
SubmitWolf directory. 
To view the Detail report, select Project Manager  from the View menu option.
Select the project you want a detail report for, and select Detail  from the Reports
menu option. 

Note: Please note that you should have some knowledge of HTML before
attempting to modify these files on your own, and we recommend that you create
a backup of this summary report before making any changes.  
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Summary  Report

A Summary Report is created for each project in the project directory. This report
is called summary.htm. This report is retained permanently and is intended for the end
customer who is being provided a submission service. 

Unlike the submission report, the summary report can be customized to include a
company name, logo etc, so as to provide your client with a more professional service. The
look and feel of the customer summary report can be changed and fully customized by
modifying the files found in the Template directory inside the SubmitWolf directory. 
To view the Summary report, select Project Manager  from the View menu option.
Select the project you want a summary report for, and select Summary  from the 
Reports  menu option. 

Note: Please note that you should have some knowledge of HTML before
attempting to modify these files on your own, and we recommend that you create a backup of
this summary report before making any changes.  

 

Importing  Project Data

SubmitWolf can build projects from data files created by external sources such as
online submission forms.The data format required is described below.
Importing a data file
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To import a form submission data file, start the Project Manager by selecting 
Project Manager  from the View menu. Then select Import  from the Project Manager 
File  menu.

Importing Projects from the Clipboard
Form submissions in the above described format that are received via email,for
example, can be imported directly from the windows clipboard. Copy the project data from
your email client, and start the Project Manager by selecting Project Manager  from
the View menu. Then select Import Clipboard  from the Project Manager File  menu.
SubmitWolf will prompt you for the name of a new project to create. Enter a new
name and click OK. The new project will be created and all available fields
populated using the data from the clipboard. 
Data file format
The output of the form must be decoded into a tagged file format with one field per
line. This is the default format of many available FormMail CGI's. eg: 

FIELD_NAME1=VALUE
FIELD_NAME2=VALUE

The following field name tags are recognized by SubmitWolf:

FIRST= First Name 

SURNAME= Surname 

TITLE= Title 

COMPANY= Company name 

STREET= Street Address 

CITY= City 

STATE= State 

POSTCODE= State Code •eg: DC‚ 

COUNTRY= Country 

TEL= Telephone 
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FAX= Fax 

MOBILE= Mobile 

TOLLFREE= Toll Free Number 

EMAIL= Email Address 

URLTITLE= Title of Web Page 

DOMAIN= Additional Domain of regional engines to submit to

LANGUAGE= Main language used on the page

DESCRIPTION= Ad Description 

URL= Associated Url 

USERNAME= Username 

PASSWORD= Passwords 

KEYWORDS= Keywords •eg: keyword1,keyword2‚ 

CATEGORY2= Category Code 

FIRST2= Replaces FIRST if encountered 

SURNAME2= Replaces SURNAME if encountered 

COMPANY2= Replaces COMPANY if encountered 

STREET2= Replaces STREET if encountered 

CITY2= Replaces CITY if encountered 

STATE2= Replaces STATE if encountered 

POSTCODE2= Replaces POSTCODE if encountered 

COUNTRY2= Replaces COUNTRY if encountered 

TEL2= Replaces TEL if encountered 

FAX2= Replaces FAX if encountered 

MOBILE2= Replaces MOBILE if encountered 

TOLLFREE2= Replaces TOLLFREE if encountered 

EMAIL2= Replaces EMAIL if encountered 

Notes:
Each field name corresponds directly to an input field of SubmitWolf. The data
must be on a single line with the exception of the DESCRIPTION field which can
span several lines. eg:

DESCRIPTON=Line 1
Line 2
Line 3
Line 4
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The CATEGORY field must have a numerical value representing a code of one of
the SubmitWolf categories. These values can be found in the 'types.dat' file. 
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Preferences

This Chapter will provide you with information on how to change the SubmitWolf 
Preferences.

 

Settings

To change browser and connection settings, select Preferences  from the Options
menu. 
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Browser:
Allows you to set the location of your default Internet browser. SubmitWolf will
use this browser to open any web pages or reports from within the program. If you find that
selecting some menu commands from within SubmitWolf are causing the program to 'lock up'
or freeze, try setting this preference. 
Open in new browser window:
Opens each URL in a new web browser window 
Concurrent Connections:
SubmitWolf can submit to a number of sites concurrently. This means that the
program can submit information to a large number of Search Engines simultaneously. This
particular parameter defines how many concurrent connections are to be used. The maximum
number of connections that can be used at any one time is 50 for SubmitWolf PRO and 1024 for
SubmitWolf Enterprise.
Connection Timeout:
The length of time SubmitWolf will wait before attempting to retry and/or abort an
unresponsive submission. The default timeout value is 8000 milliseconds. You should specify
a larger value if you are experiencing frequent timeout and abort errors during a submission. If
you specify a small timeout value, SubmitWolf will run faster, however SubmitWolf may begin
skipping engines that are too slow to respond. Unless you have a very fast internet connection
you should not use a delay of less than 2000 milliseconds as SubmitWolf may not function 
correctly.
Note: SubmitWolf will attempt to make contact with each unresponsive engine
twenty times before issuing an abort command.

 

Options

To enter a reseller id, select Preferences  from the Options  menu. 
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Reseller ID:
Allows the user to enter a reseller ID. The ID can be obtained from the Trellian
Partner program
Note, this feature is only available with in the Enterprise version of SubmitWolf  

 

firewall/Proxy  Settings

If you need to use a Firewall or Proxy to access the Internet, select Preferences
from the Options  menu and enter the Firewall/Proxy details. 

Proxy:
If you need to use a Proxy Server to connect to the internet, you should specify
the address of the proxy. If you find that you are getting constant 'Host not Found'
messages, you should check and make sure that both the address and the port of
your proxy are correct. 
Port:
Specifies the port to use if using a Proxy/Firewall. 
Username:
Specifies the username to use when accessing the Proxy/Firewall.
•Not required on all proxy servers, please ask your System Administrator for help
if unsure‚ 
Password:
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Specifies the password to use when accessing the Proxy/Firewall.
•Not required on all proxy servers, please ask your System Administrator for help
if unsure‚ 

 

Sound  Settings

To change sound settings, select Preferences  from the Options  menu. The Sound
settings in SubmitWolf allow the customization of sounds that can be triggered by
the program in response to certain events or actions. To use this feature you
simply select the event from the list provided. You can then assign a different
Wave File •*.wav‚ to any event in this list. 

Browse:
Allows you to browse your hard drive for sound files that you may assign to
certain program events 
Play:
This function allows for the preview and playback of all sound files you select 
Event/Sound:
Provides a list of program events and all of the sounds assigned to that particular
event 
OK:
Assigns the sounds to the events you have selected 
Note: SubmitWolf currently supports only standard Microsoft Windows Wave
•.wav‚ files and is limited to loading up to 3 common program events:
ProgramStart, ProgramExit and SubmitComplete.  

 

Changing  the program language 

To change the language that SubmitWolf uses, select a language from the Options  
menu.
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Interface

The main interface of SubmitWolf contains all of the most commonly used
functions available to the user and is packed with features. From here you can see
all of the submission sections laid out in a visually appealing and intuitive way. 

 

The Project Tab

This section deals specifically with the URL and web page details. 
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The Project tab fields

Field: Description:

URL Title This is the title of your web site

URL

The URL of your web site. Include the http:// prefix
when entering the URL. A URL looks like
http://www.trellian.com .To view the URL, click the
>> button.

Keywords

Enter a list of keywords relevant to your web page.
Click the >> button to edit your keywords using the
Keyword Manager. Put the most relevant keywords
first as some engines will only use the first 10 
keywords

Username
Some engines require you to specify a Username
and Password. The username is required to make
subsequent changes to your listing

Password :

Some engines require you to specify a Username
and Password. The password is required to make
subsequent changes to your listing. The password
is arbitrary, so pick any password you like

Domain :

The domain extension of your URL. For example
.au, .de, .fr If your site is related to a specific region,
but has a different URL suffix •eg: .com‚, you can
force submission by specifying an additional
domain in this field.

Language : Select the language your web site is in

Description 

•Brief‚:

Enter a brief description of your web page or its
content. •256 Characters or less‚. This description
may appear in search engine results.

Description 

•long‚:

Enter a description of your web page or its content.
•512 characters or less‚. The search results of most
engines will only display a short extract. Usually,
the extract is composed from the first few lines of
your description.

The Project tab buttons
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Button:: Description:

Submit Submits the project with the current selections

Priority
Starts PrioritySubmit Desktop to submit your web site
to engines in 48 hours. Visit Priority Submit  for more
information on paid inclusion. 

Help Displays popup help

Open Opens an existing project

Import
Imports URL title, description and keywords from a web
page. This saves you from typing the information
already contained in your web page META tags.

 

The Category Tab

This section deals specifically with the category or categories your web site falls
into. 

Many Search Engines sort and categorize URLs once they have been received.
The next step is to select the categories which best describe your web site.
Ensure that the most relevant category is listed first. 
The categories are listed in the left window pane. The categories your web site will
be submitted to are in the right window pane. 
The Category tab buttons
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Button:: Description:

Submit Submits the project with the current selections

Priority
Starts PrioritySubmit Desktop to submit your web site
to engines in 48 hours. Visit Priority Submit  for more
information on paid inclusion. 

Help Displays popup help

Clear Clears all the selected categories

 

The Contact Details Tab

This section deals specifically with the contact details of the web site's owner.
Many of the fields can be left blank if they are not appropriate. Most search
engines need all the details entered or they may reject your submission. Most
engines do not publish your contact details, however they may appear as part of
your listing on some online directories.
To clear all the contact details, click the Clear  button. 
The fields are explained below.
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Field: Description:

Company

Contact's company name. If your website is
commerical •sells something or is a business site‚
ensure you enter a Company name. If your site is non
commercial •personal homepage or information
website‚ leave the Company field blank. Some search
engines only accept business websites, and
SubmitWolf determines which engines to submit to
based on the Company field.

First 
Name

Contact's first name

Surname Contact's surname

Title Contact's title eg. Miss, Mr, Dr etc.

Email
Contact's email address. Ensure that the email
address is valid as some engines will send you a
confirmation email that requires you to respond.

Street Contact's street number and name

City Contact's city name

State
Contact's state name. Some directories may classify
your listing based on region, and may require/use this 
field.

State 
code

Contact's state code eg: DC •optional‚

Zip Contact's zip or post code

Country
Contact's country of residence. Some directories may
classify your listing based on region, and may
require/use this field.

Tel

Contact's telephone number. On some directories the
contact telephone number may appear as part of your
listing, so this field is optional, however, some
directories may not list your entry without a valid
phone number.

Fax
Contact's fax number. On some directories the fax
number may appear as part of your listing, this field is 
optional.

Mobile
Contact's mobile/cell phone number. On some
directories the mobile number may appear as part of
your listing, this field is optional.

Toll 
free

Contact or company's toll free phone number. On
some directories the toll free number may appear as
part of your listing, this field is optional.
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The Contact Details tab buttons

Button: Description:

Submit Submits the project with the current selections

Priority
Starts PrioritySubmit Desktop to submit your web site to
engines in 48 hours. Visit Priority Submit  for more
information on paid inclusion. 

Help Displays popup help

Clear Clears all the fields on the Contact Details tab

 

The Engines Tab

This section deals specifically with the engines, link lists and directories you wish
your site to be submitted to.

To clear all the engine selections, click the Clear  button. 
The engine tab is explained in detail in the Engine Selector  section of the manual.
The Engines tab columns
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Column: Description:

The first column allows you to select the engine if it
is on your submission list. You can resubmit failed
engines by selecting their checkbox and clicking the 
Submit  button.

The second column contains an image to show the
type of engine. To see the icon legend, select Icon 
Legend  from the Help menu. 

Engine This column displays the engine/list/directory name

The fourth column shows an image displaying either
a green tick, blue diamond•pending‚ or a red cross
for the status of the submission.

Last 
Submitted

The date and time the web site was last submitted to
the engine.

Submits
The number of times a web site has been submitted
to the engine.

Domains
If the engine accepts submission from specific
domains, the domain is shown in this column.

Emails
Shows the number of emails you can expect to
receive from the engine after submission

The Engine Tab buttons

Button Description

Submit Starts the submission process to the currently selected engines.

Help Launches the pop-up help dialog to provide help on any selected item.

New Creates a new engine in the list.

Edit Allows you to edit the currently selected engine.

Delete Places the currently selected engine•s‚ into the trash bin.

Select All Selects All items in the current folder.

Pending Selects the sites that have not been submitted in the current folder.

Submitted Select all sites that have been successfully submitted to in the past.

Clear Deselect all sites in the current list.

 

The Reports Tab

This section deals specifically with the submission reports. 
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The submission details for each search engine, directory or link list are available
in the reports tab. 
Exporting the report details:
After performing a submission, the reports can be exported. The reports are
exported in CSV •Comma Separated Values‚ format. If you have Microsoft Excel installed,
SubmitWolf will open Excel and display the exported table. If you dont have Excel, you are
prompted to save the file as a CSV file. You can view this file in a text editing program eg.
Wordpad. To export all the reports, select Export  from the Reports  menu. To
export only the selected reports, select the reports by holding down the Control
key and left clicking the reports. Then right click and select Export  from the popup
menu. 
The Reports tab columns
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Column: Description:

The first column allows you to select the engine if it is
on your submission list. You can resubmit failed
engines by selecting their checkbox and clicking the 
Submit  button.

The second column contains an image to show the
type of engine. To see the icon legend, select Icon 
Legend  from the Help menu. 

Engine This column displays the engine/list/directory name

The fourth column shows an image displaying either a
green tick or a red cross for the status of the 
submission.

Status

The status column describes the status of the
submission to the engine. The possible status options
are: Submitted, Failed, Skipped,Pending, Timout and
Unsupported. To view the response for an engine
submission, select the engine and click the Response
button. To view the engine's submission page, click the 
Open button. This can often show you why an engine
submission has failed eg. a 404 error means the
submission web page cannot be found.

Date
The date and time the web site was submitted to the 
engine.

Times
The number of times a web site has been submitted to
the engine.

Domain If the engine accepts submission from specific
domains, the domain is shown in this column.

URL Displays the URL of the engine submission web page.

The Reports tab buttons

Button: Description:

Submit Submits the project to the currently selected engines

Help Displays the popup help

Open
Opens the submission web page for the selected
engine in your web browser

Home
Opens the home page for the selection engine in your
web browser

Response
Opens the response web page for the engine
submissions that returned a response to SubmitWolf.
This is shown in your web browser.
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Menu Options

File

New 
Project

Creates a new Submission Project

Open Opens an Existing Submission Project File

Save Saves the current Project

Save As Saves the current Project into a different Project File

Delete Deletes the current Project

Submit Submits the current Project to all the selected search engines

Upgrade Connects to the Trellian server then checks for Software and Script 
Updates

Quit >Saves the current Project and then Exits

Edit

Cut Cuts the selected item or text from the program and places it onto the 
clipboard

Copy Copies the selected item or text to the clipboard

Paste Pastes the current data from the clipboard to the currently selected field
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View

Toolbar Toggle on or off to view/hide the Toolbar

Status Displays the connection status window

Keywords Opens the Keyword Manager, a tool to help you manage and
maintain a list of Keywords for your web page

Page Import 
Wizard

Imports Keywords, Title and Description directly from a web page

Project 
Manager

Opens the Project Manager, which allows for the organization and
batch submission of a group of projects

Reports

Submission Displays the Submission Report for the current Project

Export Exports the submission results in csv format

Options

Language Sets the language that SubmitWolf uses

Reset 
Project

Resets the current project to a default state. •Reports and Project
History are deleted‚

Preferences Allows you to change SubmitWolf's Settings
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Tools

Engine Manager Allows you to edit and add new Engine Profiles to the Engine List

Search Term 
Suggestion

Provides statistical information about the most popular search
terms used in most major search engines

Keyword 
Analysis

Allows for the analysis of any given web site to test the page
content in terms of engine ranking

Meta Tag Editor Helps you create effective meta tags to improve page ranking on
search engines

BeOnTop 
Ranking

A statistical analysis and ranking tool which will help you analyze
the top results from the major search engines

Ranking Analysis A tool to help you analyse a web site to see how it ranks in the
major search engines

Ranking Advisor Analyzes the HTML code of any given page and then provides you
with suggestions and tips on how to improve the existing 
MetaTags

Link Popularity Provides a quantitative measure of how many other sites link to 
yours

Reciprocal Link 
Checker

Allows you to see which web sites are linking to a particular URL

Calculators 3 in 1 calculator that allows you to determine your return on
investment of your Pay Per Click advertising costs

SEO Knowledge 
Base

Provides indispensable information about Search Engine 
Optimization

PPC Bid 
Comparison

Instantly and easily scout multiple pay per click engines for the
top bids on any keyword

Paid Inclusion Allows for direct access to the leading Priority Submission 
services
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Help

About Shows information about the program

Register Lets you enter your registration details into the program to turn it
into a fully-licensed version

Help Provides a handy Help window that offers advice on almost all
SubmitWolf features

Manual Selecting this will open up the manual that you are currently 
reading

Tip of the day Provides simple, yet informative Tips and Tricks to help you
understand SubmitWolf better

Icon Legend This is a list of SubmitWolf icons and provides clear explanations
of what each symbol means

FAQ Gives you a list of 'Frequently Asked Questions' to help you
identify and solve common issues with SubmitWolf

Acceptable Use 
Policy

This is an informative and clearly written policy on the acceptable
usage of SubmitWolf
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